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1 Basics of Fluid Flow Analysis 
 

1.1 Tetrahedral and Boundary Layer Meshes 
For most analysis types, the "Bricks and Tetrahedral" solid mesh type is ideal and is the default.  This 
mesh creates high quality elements at the exterior of the model and lower quality elements at the interior. 
However, since the interior mesh is important for a fluid flow analysis, the "All Tetrahedra" solid mesh 
type is selected by default for all models that are initially defined as fluid flow analyses.  This can also be 
specified manually by pressing the "Options…" button on the "3D Mesh Settings" dialog.  Select the 
"Solid" icon on the left side of the dialog and then select the "All tetrahedra" radio button in the 
"General" tab.  The all tetrahedra mesh type will create all 4-noded elements.  This will result in higher 
quality and more uniform elements throughout the model than the "Bricks and tetrahedral" mesh option 
would. 
 
An additional solid mesh type, which can be used for fluid flow models, is the boundary layer mesh.  This 
is specified by selecting the "Tetrahedra and wedges (boundary layer)" radio button.  The boundary 
layer mesh type will create thin boundary layers of wedges at all of the exterior surfaces of the model.  
Tetrahedral elements will be created for the remaining interior of the model.  This will allow you to capture 
the results more accurately around the walls of the model, where velocity gradients are steepest.  In 
addition, this mesh type ensures the generation of interior nodes in small and/or narrow fluid passages, 
which might otherwise be spanned by a single tetrahedra.  This would make flow impossible due to the 
absence of interior nodes (since the exterior nodes will be constrained to zero-velocity). 
 
When either of these mesh types are selected, the "Tetrahedra" tab will become available. This tab is 
shown below. 
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The "Tetrahedral meshing options" section will allow you to control the quality of the tetrahedral 
elements.  The "Target edge length based on" drop-down box will determine how the value in the 
"Target edge length" field is used to control the size of the tetrahedral elements as follows: 
 

• If the "Fraction of mesh size" option is selected, the value in the "Target edge length" field will 
be multiplied by the surface mesh size to determine the size of the tetrahedral elements. 

• If the "Absolute mesh dimension" option is selected, the value in the "Target edge length" field 
will be used for the size of the tetrahedral elements. 

 
You can control the relative size of adjacent tetrahedral elements in areas where the mesh transitions 
from large element to small elements using the "Transition rate" field.  The value in this field will be the 
ratio of the average edge lengths of adjacent elements.  This value must be greater than 1.  A large value 
will result in a lower quality mesh.  The value in the "Quality" field will be used as an upper limit for the 
aspect ratio of the elements. 
 
The "Boundary layer options" section can be used to control the wedge element boundary layers. This 
section will only be available if the boundary layer mesh type is selected.  The "Extrusion distance 
based on" drop-down box will determine how the value in the "Total extrusion distance" field is used to 
control the combined length of all of the boundary layers as follows: 
 

• If the "Fraction of mesh size" option is selected, the value in the "Total extrusion distance" field 
will be multiplied by the surface mesh size. The resulting value will be the total thickness of the 
boundary layers. 

• If the "Absolute length dimension" option is selected, the value in the "Total extrusion distance" 
field will be the total thickness of the boundary layers. 

•  If the "Percentage average local size" option is selected, the value in the "Total extrusion 
distance" field will be used as a percentage of the surface mesh size in the area of the boundary 
layer. 

 
You can specify how many boundary layers will be created in the "Layers" field. The "Growth rate" field 
is used to specify the ratio of the mesh sizes between adjacent layers.  This value must be greater than 
one.  The outermost layer of wedges will be the thinnest and the subsequent layers will each increase in 
thickness. 
 
 
NOTE: It is strongly recommended that you exclude all inlet and outlet surfaces from the boundary layer 
mesh to avoid poor mesh quality at the fluid inlets and outlets.  The basic guideline is to use boundary 
layers only where a real wall exists.  To exclude surfaces, first select the ones to be excluded, right-click 
in the display area, and choose the "CAD Mesh Options: Exclude From Boundary Layer" command. 
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1.2 Loading Options 
For most fluid flow analyses, the flow is caused by a known pressure or velocity at some area of the 
model.  Therefore prescribed velocities and pressures are the most common fluid flow loads.  In addition 
to these loads, prescribed inlet/outlets allow the user to specify for which exterior surfaces of the model 
the velocities and pressures are unknown. 
 
 

1.3 Prescribed Inlet/Outlets 
A prescribed inlet/outlet can be applied to any node or surface of a model.  A prescribed inlet/outlet 
specifies an area of the model where the velocity and pressure of the flow is not known.  A zero-traction 
state will be applied where a prescribed inlet/outlet exists.  This will result in a near zero pressure. 
 
If the "Use Automatic Constraints" checkbox in the "Formulation Options" screen which can be 
accessed within the “Solution” tab of the "Analysis Parameters" dialog is activated, the program will 
automatically add zero velocity boundary conditions to all nodes on exterior surfaces that do not have a 
prescribed velocity or pressure/traction load applied and are not specified as a prescribed inlet/outlet.  
These are commonly called wall constraints.  This checkbox is activated by default and is recommended 
because it eliminates the need for the user to manually apply the zero-velocity constraints to every 
surface of the model.  This option is always active while using the "Segregated" formulation.  
 
A prescribed inlet/outlet can be specified by selecting the desired node or surface and clicking on the 
"Setup: Fluid Flow Loads: Inlet/Outlet” command.  A red "I" symbol will appear on each selected node 
for nodal-based inlet/outlets.  For surface-based inlet/outlets, a green "I" symbol will appear at every node 
along the selected surface(s). 
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1.4 Prescribed Velocity 
Prescribed velocities can be applied to any node, edge or surface of a model.  Prescribed velocities 
applied to edges or surfaces will apply the velocity conditions to every node on the edge or surface.  A 
prescribed velocity can be applied to a model by selecting the desired node, edge, or surface and clicking 
on the "Setup: Fluid Flow Loads: Prescribed Velocity” command.  For a selected surface, the dialog 
shown below. 
 

 
  
 
For each direction in which you want to constrain the velocity, activate the checkbox.  If a checkbox is not 
activated, the velocity in that direction will have no constraint.  For example, if you want fluid to flow into a 
model at 1 in/s in the X direction, activate all three checkboxes.  Type "1" in the "X Magnitude" field and 
leave the other values at 0.  If the "Y Magnitude" and "Z Magnitude" checkboxes are not activated, the 
fluid will be able to flow at a non-zero magnitude in those directions. 
 
Generally, it is suggested that you use fully-constrained velocity components except for when you 
intentionally wish to model symmetrical boundary conditions (that is, boundaries where only the normal 
velocity is zero).  For symmetrical models, leave the velocity in the directions parallel to the symmetry 
plane undefined and set the velocity normal to the symmetry plane to zero. 
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1.5 Load Curves 
As mentioned previously, the magnitudes of prescribed velocities, pressures and tractions follow load 
curves throughout a fluid flow analysis.  Load curves are necessary for both steady and unsteady fluid 
flow analyses.  Though time is not meaningful for a steady fluid flow analysis, the load curves help 
provide a sequence of guesses for the nonlinear equilibrium equations.  This helps the solution converge.  
For an unsteady fluid flow analysis, load curves control the magnitudes of prescribed velocities, 
pressures, tractions and gravity as a function of time.  Load curves are defined in the "Analysis 
Parameters" dialog.  This can be accessed by right clicking on the "Analysis Type" heading in the 
browser and selecting the "Edit Analysis Parameters…" command.  For a steady fluid flow analysis, the 
"Analysis Parameters" dialog will appear as shown below. 
 

 
 
 
For an unsteady fluid flow analysis, the "Initial multiplier" field will not appear within the "Load Curves" 
tab of the dialog.  Instead, the first row of the "Custom Load-Stepping Settings" table will indicate the 
initial condition.  In addition, the "Pseudo-Time" column will be renamed "Time" because the values 
represent actual, absolute time points for unsteady fluid flow analyses. 
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A proper load curve will provide rapid convergence for a fluid flow model.  Since fluid flow is a nonlinear, 
iterative process, the loads will normally start with a multiplier of 0 and ramp up to the final value.  At least 
two points are required on the load curve.  Use the "Add Row" button to add additional rows to the 
spreadsheet.  The "Delete Row" button will remove the current row from the spreadsheet.  The "Sort" 
button will sort the spreadsheet rows based on increasing time.  Specify the time for each point in the 
"Time" or "Pseudo-Time" column.  Specify the corresponding load multiplier in the "Multiplier" column. 
 
Note: For a steady flow analysis, the value in the "Initial Multiplier" field represents the first point of the 
load curve and the values in the first row of the table represent the second point of the load curve. 
 
Each time interval can be split into multiple calculation steps using the "Steps" column.  This entry 
determines how many steps are performed in the time interval starting on the previous row and ending on 
the current row.  The value on the first row is not used in an unsteady analysis.  For each calculation step, 
the processor will perform up to a maximum number of iterations, determined as a function of the number 
specified in the "Max Iterations" column.  The actual number of iterations is not the number specified by 
the user.  Specifically, the processor will allow up to 95 times the user-specified “Max Iterations” number 
for steady fluid flow and up to 47 times this value for unsteady fluid flow. 
 
The processor will move on to the next step as soon as convergence occurs.  So, the maximum number 
of iterations will only be performed if convergence does not occur sooner.  If the solution does not 
converge (or is diverging), then the processor will either reduce the time step (and therefore the load 
increment) or it will use an inertial relaxation technique.  The method used depends upon the solution 
formulation. 
 
The values on Row 2 of the “Time-Stepping Settings” table correspond to the time interval between Row 
1 and Row 2, and so on.  Therefore, the value in the "Max Iterations" column for Row 1 has no affect for 
an unsteady analysis, since this is the initial condition.  
 
Use the "Turbulence" column to activate the turbulence calculation.  Specifying a value of 0 in this 
column will deactivate turbulence for that time interval. Specifying a value of 1 in this column will activate 
turbulence for that time interval.  The purpose of this calculation is to capture real turbulence effects in 
fluid flow, such as the additional turbulence viscosity, kinetic energy, and vortex dissipation rate. This 
option should NOT be used for time steps involving laminar flow.  The additional turbulence viscosity 
would tend to degrade the accuracy of the solution, since there is no turbulence velocity in laminar flow 
situations. 
 
Because of the extra effects that the turbulence option captures, it will also help convergence, which 
typically becomes easier as viscosity increases.  However, this is not the primary purpose of the option 
and it should only be used where appropriate (transitional and turbulent flow). 
 
Note: The value in Row 2 corresponds to the time interval between Row 1 and Row 2, and so on.  For an 
unsteady analysis, the value in Row 1 is the initial condition only and does not represent any time interval 
by itself.  Therefore, the value in the "Turbulence" column for Row 1 has no affect for an unsteady 
analysis. 
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The "Upwind" column can be used to specify whether or not a time marching algorithm is used for the 
time integration scheme.  Specifying a value of 1 in this column for a given row will implement the time 
marching algorithm for the time interval represented by that row.  A value of zero will prevent usage of the 
algorithm.  The “Upwind” option is applicable to unsteady fluid flow analysis only.  Activating this option is 
recommended, as it generally improves the accuracy of the results. 
 
Note: The value in Row 2 corresponds to the time interval between Row 1 and Row 2, and so on.  For an 
unsteady analysis, the value in Row 1 is the initial condition only and does not represent any time interval 
by itself.  Therefore, the value in the "Upwind" column for Row 1 has no affect for an unsteady analysis. 
 

1.6 Convergence Controls for Formulation Options 
Because fluid flow is a nonlinear process, it may be necessary for the processor to perform several 
iterations.  Then, the question becomes how to know whether the solution at any step has converged or 
not.  The following four columns of the “Custom Load-Stepping Settings” table are applicable only to the 
"Mixed GLS" and "Penalty" formulations, as specified within the "Solution" tab of the Analysis Parameters 
dialog.  The columns used for the "Segregated" formulation will be discussed later. 
 
The "Residual Type" column can be used to indicate whether or not the velocity residual (that is, the 
error in the Navier-Stokes equation) is to be used for the convergence criteria and also whether the 
absolute or relative norm is to be used.  Specifying a value of 1 in this column will use the ratio of the 
current to previous norm for that time interval.  This is the recommended setting.  Specifying a value of 0 
will use the absolute norm. Specifying a value of -1 will ignore the residual calculation.  The value in Row 
2 corresponds to the time interval between Row 1 and Row 2, and so on.  Therefore, the value in the 
"Residual Type" column for Row 1 has no affect for an unsteady analysis.  If the calculated residual norm 
is less than the tolerance specified in the "Residual Tol" column, the calculation step has converged, and 
the processor will move on to the next step.  For an unsteady fluid flow analysis, the value in Row 1 
indicates the initial condition (at time = 0).  The value in each subsequent row corresponds to the time  
interval between the previous and current rows.  Therefore, for an unsteady analysis, the value in the 
"Residual Tol" column of Row 1 has no affect. 
 
The "Increment Type" column can be used to indicate whether or not the velocity increment (that is, the 
change in velocity from step to step) is to be used for the convergence criteria and also whether the 
absolute or relative norm is to be used.  Specifying a value of 0 in this column will use the absolute norm 
for that time interval.  This is the recommended setting.  Specifying a value of 1 will use the ratio of the 
current to the previous norm.  Specifying a value of -1 will ignore the residual calculation.  For an 
unsteady fluid flow analysis, the value in Row 1 indicates the initial condition (at time = 0).  The value in 
each subsequent row corresponds to the time interval between the previous and current rows.  Therefore, 
the value in the "Increment Type" column for Row 1 has no affect for an unsteady analysis.  If the 
calculated increment norm is less than the value in the "Increment Tol" column, the calculation step has 
converged, and the processor will move on to the next step. 
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1.7 Output and Printout Intervals 
The value in the "Output Interval" column is the number of calculation steps between outputs of the 
results.  This parameter affects what results are available in the Results environment.  A value of 1 
indicates that results are written at every step, a value of 2 indicates results are written at every other 
step, and so on.  The value in the "Printout" column is the number of calculation steps between outputs 
of the text results.  This input affects what results are written to the summary file.  A value of 1 indicates 
that results are written at every step, a value of 2 indicates results are written at every other step, and so 
on. 
 
 

1.8 Convergence Controls for the "Segregated" Formulation Option 
The final four columns of the "Time-Stepping Settings" table control the convergence criteria 
for the "Segregated" formulation, as specified within the "Solution" tab of the Analysis Parameters dialog.  
The "Norm-V Type" and "Norm-P Type" are the type of convergence criteria to use for the velocity and 
pressure calculations, respectively.  The acceptable values are 0 (use the absolute norm) and 1 (use the 
ratio of the current to previous norm).  The latter type is the default for both velocity and pressure 
convergence.  If the calculated norms are less than the tolerance specified in the "Velocity Norm" and 
"Pressure Norm" columns, the calculation step has converged, and the processor will move on to the 
next step. 
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2 Project 1 - Venturi Model 
 

2.1 Line Up 
Concepts that will be covered during this project: 
 

• Meshing a CAD solid model with a boundary layer mesh. 
• Specifying a refinement point to produce local mesh refinement. 
• Applying prescribed velocities. 
• Applying prescribed inlet/outlets. 
• Applying symmetry constraints. 

 
Objective 
Mesh and perform an unsteady fluid flow analysis on the model of the fluid in the venture shown below. 
The fluid passages in the immediate area of the venturi are very narrow.  So, local mesh refinement will 
be used to produce a greater concentration of nodes in the interior of the flow paths. 
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Geometry 
Use the file, Venturi Model.step. Specify a refinement point at coordinates (0, 0, 0) with a radius of 0.5" 
and a divide factor of 4.  Mesh the model with an absolute mesh size of 1/8" (0.125) using a boundary 
layer mesh.  Exclude the inlet surface (the one with a 45 in/s prescribed velocity in the -Y direction), the 
two prescribed inlet/outlet surfaces, and the symmetry surface from receiving a boundary layer mesh. 
 
 
Loading 
45 in/s velocity in the –Y direction as shown in the image shown. 
 
 
Constraints 
Symmetry conditions along symmetry plane.  Prescribed inlet/outlets at two locations as shown in the 
image shown. 
 
 
Element 
3-D 
 
 
Materials 
Water 
 
 
Load curve 
 

Time Multiplier Steps 
0.0 0.0 1 
1.0 1.0 20 

 
 
Results 
To save time, you may stop the analysis after the solution converges for a couple of time steps.  Then, to 
review the completed results, open the results archive file that is provided. 
 

Maximum Velocity 
Magnitude 

(in/s) at 1 second 
~303 
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2.2 Instructions 
 

1. Open Venturi Model.STEP in Autodesk Simulation 2012. 
 
 

2. Choose the option to Use STEP file units if it is not already selected and click the OK button. 
The original STEP file length unit is inches. 

 

 
 
 

3. A dialog will appear asking you to choose the analysis type for this model.  Click the arrow to the 
right of the analysis type field, select the "Fluid Flow" pull-out menu, and choose the "Unsteady 
Fluid Flow" type.  Click OK to continue. 
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4. Click the Mesh tab | Mesh panel | 3D Mesh Settings to change the mesh settings. 

 

 
 
 

5. Click the Options button. 
 

 
 
 

6. Select the Absolute Mesh Size option in the Type drop-down box and enter 0.125 in the Size 
field for the surface mesh settings. 
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7. Select the Solid icon on the left side of the Model Mesh Settings dialog.  Then select the 

Tetrahedra and wedges (boundary layer) radio button for solid mesh type.  Click OK twice to 
complete the mesh settings. 

 

 
 
 

NOTE: The boundary layer mesh type will create thin boundary layers of wedges at all of the 
exterior surfaces of the model. Tetrahedral elements will be created for the remaining interior of 
the model. This will allow you to capture the results more accurately around the walls of the 
model, where velocity gradients are steepest. 

 
 

8. Before we begin the meshing process a mesh refinement point needs to be added.  Click Mesh 
tab | Refinement Points panel | Specify. 
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9. Complete the following items in the Refinement Point Browser dialog:  
 

• Press the Add button to start adding a new refinement point. 
• Double click on the first cell under the Radius column and enter 0.5. 
• Double click on the first cell under the Mode column and change the option from Size to 

Divide. 
• Double click on the first cell under the Divide Factor column and Enter 4. 
• Press the OK button. 

 

 
 

 
10. Click on the Selection tab | Select panel | Surfaces. 
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11. Click on the large flat surface along the symmetry plane. 

 

 
 

 
12. Click on the Selection tab | Shape panel | Rectangle.  Change the viewing direction to Top 

view. 
 

 
 
 

13. Holding down the <Ctrl> key, draw a box around each of the edges marked below on the model. 
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14. Right-click in the graphics display area and select the CAD Mesh Options | Exclude from 

Boundary Layer option. 
 

 
 
 

15. Click on the Mesh tab | Mesh panel | Generate 3D Mesh to start the meshing process. 
 

 
 
 

16. Press the No button when asked to view the meshing results. 
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17. Add a Prescribed Velocity to the symmetry plane.  Change the selection to Point for the Shape.  

Click on the Selection tab | Shape panel | Point. 
 

 
 
 

18. Click on the large flat surface along the symmetry plane as shown below. 
 

 
 
 

19. Click on the Setup tab | Fluid Flow Loads panel | Prescribed Velocity button.  Check the Z 
Magnitude checkbox and click OK to complete. 

 

 
 

NOTE: Generally, it is suggested that you use fully-constrained velocity components except for 
when you intentionally wish to model symmetrical boundary conditions (that is, boundaries where 
only the normal velocity is zero). For symmetrical models, leave the velocity in the directions 
parallel to the symmetry plane undefined and set the velocity normal to the symmetry plane to 
zero. 
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20. Now we will add the inlets and outlets.  Holding down the <Ctrl> key, select the Left Face and 
Front Face as shown below. 

 

 
 
 

21. Click on the Setup tab | Fluid Flow Loads panel | Inlet Outlet button. 
 

 
 

NOTE: A prescribed inlet/outlet specifies an area of the model where the velocity and pressure of 
the flow is not known. A zero-traction state will be applied where a prescribed inlet/outlet exists. 
This will result in a near zero pressure. 
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22. Add the 45 in/s Prescribed Velocity to the Right Face.  Select the Right Face as shown below. 
 

 
 
 

23. Click on the Setup tab | Fluid Flow Loads panel | Prescribed Velocity and complete the 
following items: 

 
• Activate the X Magnitude checkbox. 
• Activate the Y Magnitude checkbox. 
• Type -45 in the Y Magnitude field. 
• Activate the Z Magnitude checkbox. 
• Press the OK button. 
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24. Now the material will be assigned as water.   Right-Click on the Material node in the FEA Editor 

Browser for Part 1. 
 

 
 
 
 

25. Expand the Liquid folder and select Water as the material.  Click OK to complete the material 
assignment. 

 

 
 
 

 
26. Click Setup tab | Model Setup panel | Parameters to open the Analysis Parameters dialog. 
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27. Complete the following items in the Analysis Parameters dialog under the Load Curves tab: 
 

• Press the Add Row button. 
• Type 0 in the first row of the Multiplier column in the Time-Stepping Settings table. 
• Type 20 in the second row of the Steps column. 
• Press the OK button. 

 

 
 
 

28. Check the analysis model before starting the solving process.  Click the Analysis tab | Analysis 
panel | Check Model.  This will start the Model Validation process to ensure the model is ready 
for solving. 
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29. Switch back to the FEA Editor environment by clicking Tools tab | Environments panel | FEA 
Editor. 

 

 
 
 

30. Run the analysis by clicking Analysis tab | Analysis panel | Run Simulation.  The analysis will 
take approximately five (5) minutes depending on the computer resources. 

 

 
 
 

31. To improve the viewing of the fluid flow click View tab | Appearance panel | Loads and 
Constraints to turn off the display of the loads and constraints on the model. 
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32. The results for the model should look similar to the image below. 

 

 
 
 
 

33. Click on the on the Results Contours tab | Load Case Options panel | Previous and Next 
buttons to toggle through the velocity results throughout the analysis. 

 

 
 
 

34. Click on the on the Results Contours tab | Captures panel | Start button to animate the velocity 
results throughout the analysis. 
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